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Fractal Textures

Fractal Texture Composer is derived from the latest texture creation techniques for the 
needs of    three dimensions. It uses a fractalization method combined with the generation of
a random distribution. This technique is applied to simple 2D elements, such as : concentric 
circles, stripes, sinusoids etc..., and also to colors of the texture.
Color gradation is used to generate the color associated to the graphic elements.
This gradation and the graphic elements can be duplicated to infinity, an element being 
situated between 0 and 1. By associating a random disruption during the geometric 
distribution of the elements, a fractal texture is obtained.

The software also simulates the aspect of the texture. When a texture has relief, or 
coarseness by the association of bump-mapping, you create the visual impression of relief. 
The texture must be illuminated in order to simulate shading and reflections. You will be able
to set the parameters of your lighting, as well as the properties of the material.

Some texture ideas garnered from SIGGRAPH '85 Volume 19 Number 3, "An Image Synthesizer" By Ken 
Perlin.
Further Ideas Garnered from "The RenderMan Companion" (Addison Wesley).



Texture Document

The texture document is represented by the window where it displays your texture. The 
software will recalculate the texture by a double-click inside the window. The texture can be 
calculated to infinity. It is possible to move the texture within the window. Click in the 
window, keep the left mouse button pressed down, then move your mouse. You will see a 
red line displayed that represents the movement of the texture. When you have repositioned
your texture correctly, release the mouse button, and the software will recalculate the 
texture at its new position.



Command Block
Click the area that you would like more information about.

The Command Block permits you to set the parameters of the current texture.



Texture Type

Choose the type of texture that you would like to apply to the current texture.
The software currently offers 13 different types of textures. When you click on one of these 
types from the list, it is immediately applied to the active texture.



Detail

This parameter represents the number of iterations during the fractalization of the texture.
The higher the parameter’s value is, the more detailed the resulting texture will be. But also 
note that the calculation will take longer. Its value must be between 0 and 256.



Turbulence

This parameter represents the intensity of the disruptions introduced during the calculation 
of the texture.
The higher the parameter’s value is, the more disrupted the texture will be. Its value must 
be between 0 and 1.



Scale of the Texture

This group permits you to increase or decrease the part of the texture visualized in the 
window.
For a scale factor of 1, the texture is calculated between 0 and 1 , for a scale factor of 2 , the
texture is calculated between 0 and 2.
You can independently assign scale to the X axis (horizontal axis), and the Y axis (vertical 
axis).



Relief Type

Choose the type of relief that you would like to apply to the current texture.
The software currently offers 5 different types of relief. When you click on one of these types 
from the list, it is immediately applied to the active texture.



Intensity

This parameter permits you to set the visual intensity of the relief. Its value must be 
between 0 and 10. If the intensity is 0, the software will not calculate the relief.



Scale of the Relief

This group permits you to increase or decrease the part of the relief visualized in the 
window.
For a scale factor of 1, the relief is calculated between 0 and 1 , for a scale factor of 2 , the 
relief is calculated between 0 and 2.
You can independently assign scale to the X axis (horizontal axis), and the Y axis (vertical 
axis).



Reflection

This button permits you to set the parameters for the physical aspect of the illuminated 
material, by a light source. The software displays a dialog box named Reflection Parameters.



Reflection Parameters dialog box

Click the area that you would like more information about.



Confirm

Confirm and close the dialog box.



Cancel

Cancel and close the dialog box.



Color of the reflection

Permits you to adjust the color of the reflection generated by the lighting. Click and move 
one of the red, green or blue components. The resulting color is displayed in the window on 
the right. By clicking on this, you can adjust the color with the windows dialog box.



Brilliance of the texture

Permits you to adjust the brilliance of the texture, according to the three RGB components. 
The greater the value is, the more limited the dimension of the reflection is. Click and move 
one of the red, green or blue components. The resulting color is displayed in the window on 
the right. By clicking on this, you can adjust the color with the windows dialog box.



Lighting

This button permits you to set the parameters of the light source.
The software displays a dialog box named Lighting Properties.



Lighting Properties dialog box

Click the area that you would like more information about.



Confirm

Confirm and close the dialog box.



Cancel

Cancel and close the dialog box.



Color of the light source

Permits you to adjust the color of the light source. Click and move one of the red, green or 
blue components. The resulting color is displayed in the window on the right. By clicking on 
this, you can adjust the color with the windows dialog box.



Direction of the light source

Permits you to adjust the direction of the light source.
After adjusting the direction, the reflection is positioned differently on the texture. The half 
sphere simulates a bump in the texture. The vector that links the sun to the center of the 
sphere, indicates the current direction of the lighting. To modify this direction, click inside 
the sphere, and the sun is immediately repositioned at the place where you have just 
clicked. Keep the mouse button pressed, move the mouse and you will see the vector move. 
When you release the mouse button, the software recalculates the position of the reflection 
on the sphere.



Preview

This button permits you to launch the calculation of the current texture.



Texture Libraries
Click the area that you would like more information about.

The texture library permits you to visualize a group of textures residing on the disk. The 
software supplies a startup library by default, consisting of a group of textures that 
represent the possibilities of the software.



Add a Texture to the Library

The software provides a dialog box to select a texture to add to the library.
The selected texture is opened and an icon is added in the display window.



Load a Texture Library

The software provides a dialog box to select a library.
The selected library is opened and all the textures are loaded and displayed in the display 
window.



Delete a Texture from the Library

Delete the selected texture from the library (surrounded by a blue frame).



Save a Texture Library

The software provides a dialog box to give a name to the library.



Display the Library

Every texture in the library is displayed in a window. A scroll bar permits you to move inside-
left/-right. The selection of a texture is performed by a simple click, it is then surrounded by 
a blue frame. To apply a texture from the library to the current texture in the work plan, you 
need only to double-click on it.



Colors Palette
Click the area that you would like more information about.

This dialog bar, displays the color palette associated to the current texture. These colors 
permit the software to calculate the gradation in your texture.



Degrade two Colors

This button initiates the degrade option. To execute the operation, click on the first color to 
degrade, then on the second color, in the display part of the palette. The software calculates
a linear gradation between these two colors and the display in the palette.



Modify a Color

This button permits you to modify the color selected in the palette (surrounded by a blue 
frame).
The software displays a dialog box for adjusting windows colors. Modify your color, then click
OK. The box is erased and the degraded color is displayed.



Display the Palette

Display the colors in the palette. To select a color, simply click inside the corresponding box. 
A double-click permits you to modify this color with the windows dialog box.



File menu Commands

The File menu provides the following commands :

New Create a new texture.
Open Open an existing texture.
Save Save an open texture under the same file name.
Save as Save an open texture under a new file name that you specify.
Print Print a texture.
Print preview Display the texture on the screen as it will appear to the printer.
Printer setup Select a printer and a printer connection.
Exit Quit Fractal Texture Composer.



Edit menu Commands

The Edit menu provides the following commands :

Image 
Format

Modify the image format.



Image Format Command (Edit menu)

The texture is displayed with a default format of 160X120 pixels. The software permits you 
to modify this format and provides a dialog box named Image Format.



Image Format dialog box

To modify the format, select one of the predefined format options, then click OK. The new 
format is applied to the current texture, the associated window is repositioned and the 
texture displayed.
If you choose free format, the software provides a dialog box named Free Format.



Free format dialog box

Enter the horizontal and vertical resolution required in the editing box, then click OK.



View menu Commands

The View menu provides the following commands :

Toolbars Display or hide the toolbars.
Status bar Display or hide the status bar.

Command Display or hide the command block.
Library Display or hide the texture library
Palette Display or hide the colors palette



Command block Command (View menu)

Use this command to display or hide the command block. A checkmark appears beside the 
command when the command block is displayed.

See Command Block to obtain help on the use of the command block.



Library Command (View menu)

Use this command to display or hide the library. A checkmark appears beside the command 
when the library is displayed.

See Texture Libraries to obtain help on the use of the library.



Palette Command (View menu)

Use this command to display or hide the colors palette. A checkmark appears beside the 
command when the palette is displayed.

See Colors Palette to obtain help on the use of the palette.



Window menu Commands

The Window menu provides the following commands, that permit you to arrange the 
window display for several documents in the application window :

New window Create a new window that displays the same document.
Cascade Arrange the windows to overlap so that each title bar is 

visible.
Tile Arrange the windows to fit next to each other on the 

desktop.
Arrange icons Arrange the icons along the lower edge of the desktop.
Split Split the active window into panes.
1, 2, Window . Go to the specified window.



? menu Commands (Help)

The ? menu (Help) provides the following commands, that give help on this application : 

Help Topics Provides a help index in which you can obtain help.
About Displays the version number of this application.



New Command (File menu)

Use this command to create a new document in Fractal Texture Composer.

You can open an existing document with the Open command.

Shortcuts

Toolbars :
Keys : CTRL+N



Open Command (File menu)

Use this command to open an existing document in a new window. You can have several 
documents open at the same time. Use the Window menu to pass from one document to 
another. See the help topic 1, 2, Window command.

You can create new documents with the New command.

Shortcuts

Toolbars :
Keys : CTRL+O



Open dialog box 

The following options permit you to indicate the file that you would like to open :
File Name

Type or select the name of the file that you would like to open. A box displays a list of 
files that support the extension that you choose in the « File Types » field.

File Types
Select the type of file that you would like to open :
*.ftc

Drives
Select the drive where Fractal Texture Composer saved the file that you would like to 
open. 

Directories
Select the directory where Fractal Texture Composer saved the file that you would like to 
open.

Network...
Choose this button to connect to a network drive, by assigning a new drive letter. 



Close Command (File menu)

Use this command to close all windows containing the active document. Fractal Texture 
Composer prompts you to save the modifications made to your document before closing. If 
you close a document without saving it, you will lose all the modifications made since the 
last save. Before closing a document without a name, Fractal Texture Composer displays the 
Save as dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon in the document window, as indicated
below :



Save Command (File menu)

Use this command to save the active document under its current name and directory. When 
you save a document for the first time, Fractal Texture Composer displays the Save as dialog
box that permits you to attribute a name to your document. If you would like to change the 
name or directory of an existing document before saving, choose the Save as command.
Shortcuts

Toolbars :
Keys : CTRL+S



Save as Command (File menu)

Use this command to save and name the active document. Fractal Texture Composer 
displays the Save as dialog box that permits you to name your document. 

To save a document under its current name and in its existing directory, use the Save 
command.



Send command (File menu)

Use this command to send the active document by electronic mail.    This command presents
a mail window with the active document attached to it.    You may then fill out the To: field, 
Subject: field, etc., and add text to the body of the message if you wish.    When you are 
finished, you may click the "Send" button to send the message.



Save as dialog box

The following options permit you to specify the name and location of the file that you would 
like to save :
File Name

Type a file name to save a document under a different name. A file name can include up 
to eight characters and its extension up to three characters. Fractal Texture Composer 
adds the extension that you specify in the « Save as Type » box.

Drives
Select the drive where you would like to save the document.

Directories
Select the directory where you would like to save the document.

Network...
Choose this button to connect to a network drive, by assigning a new drive letter. 



1, 2, 3, 4 Command (File menu)

Use the numbers and names of the files displayed at the bottom of the File menu to open 
one of the last four documents that were open. Choose the number corresponding to the 
document that you would like to open.



Exit Command (File menu)

Use this command to terminate your Fractal Texture Composer session. You can also use the 
Close command from the application’s System menu. Fractal Texture Composer asks you if 
you would like to save documents when modifications have not been saved.

Shortcuts
Mouse : Click twice on the application’s System menu button.

Keys : ALT+F4



Undo Command/Impossible to undo (Edit menu)

<< Your application's user interface for Undo may differ from the one described below. 
Modify this help text accordingly. >>

Use this command to cancel the last modification operation, if possible. The name of the 
command varies according to the last action performed. The Cancel command becomes the
Impossible to cancel command if the last action is irreversible.

Shortcuts

Toolbars :
Keys : CTRL+Z or

ALT-RETURN-BACK



Cancel redo Command (Edit menu)

<< Write application-specific help here. >>



Toolbars Command (View menu)

Use this command to display or hide the toolbars, which includes buttons that execute the 
most frequently used commands in Fractal Texture Composer, such as Open File. A 
checkmark appears beside the command when the toolbars are displayed.

See Toolbars to obtain help on the use of the toolbars.



Toolbars

The toolbars are displayed above the application window and under the menu bars. The 
toolbars permit you to quickly access a number of tools used in Fractal Texture Composer, 
with the help of the mouse.

To hide or display the toolbars, choose View Toolbars (ALT, V, T).

Click For

Open a new document.

Open an existing document. Fractal Texture Composer displays the Open dialogue 
box, in which you can select and open the file of your choice.

Save the document or active texture under its current name. If no name has been 
given to the document, Fractal Texture Composer displays the Save as dialogue box.

Print the active document.



Status bar Command (View menu)

Use this command to display or hide the status bar, which describes the action executed by 
the command chosen or the button pressed on the toolbars, and the status of the keyboard 
lock. A checkmark appears beside the command when the status bar is displayed.

See Status bar to obtain help on the use of the status bar.



Status bar

The status bar is displayed at the bottom of the Fractal Texture Composer window. To display
or hide the status bar, choose View Status bar.

When you move through the menus with the help of the mouse or arrow keys, the left part of
the status bar describes each of the commands. Likewise, when you click the buttons on the 
toolbars, this part displays messages describing the actions associated to each of these 
buttons. If you don’t want to execute the command, position the mouse pointer somewhere 
other than on that button, then release the mouse button.

The area on the right side of the status bar indicates when the following keys are locked :

Indicator Description
CAP The CAPITALS LOCK key is locked.
NUM The NUMERIC LOCK key is locked.
SCR The SCOLL LOCK key is locked.



New window Command (Window menu)

Use this command to open a new window that has the same contents as the active window. 
You can open several windows to display different parts or views of the same document. If 
you modify the contents of one window, all of the windows containing the same document 
will reflect these modifications. When you open a new window, this becomes the active 
window and is displayed over top of all the other open windows.



Cascade Command (Window menu)

Use this command to arrange the open windows to overlap so that each title bar is visible. 



Tile Command (Window menu)

Use this command to arrange the open windows in smaller sizes to fit next to each other on 
the desktop.



Tile horizontal Command (Window menu)

Use this command to arrange the open windows on top of each other.



Tile vertical Command (Window menu)

Use this command to arrange the open windows side by side.



Arrange icons Command (Window menu)

Use this command to arrange the icons of minimized windows along the lower edge of the 
main window. If one open document window occupies the bottom of the main window, it 
could be that the icons are not all visible in the bar or that they are hidden by the document 
window.



Split Command (Window menu)

Use this command to split the active window into panes. To move the splitting bars, use the 
mouse or the arrow keys. When you have finished, click with the mouse or use the Enter key 
to set the new position of the bars. The action of pressing the Escape key maintains the 
splitting bars in their original position. << In a single document interface application, this 
command will appear on the View menu. >>



1, 2, Command... (Window menu)

Fractal Texture Composer displays the list of open document windows at the bottom of the 
Window menu. A checkmark appears beside the name of the document in the active 
window. Choose a document to start from to make it the active window. 



Index Command (Help menu)

Use this command to display the opening help screen. Starting from the opening screen, you
can consult detailed instructions concerning the use of Fractal Texture Composer and gain 
access to different types of reference information. 

Once the help file is open, you can click on the « Index » button each time that you would 
like to return to the opening screen.



Using help Command (Help menu)

Use this command to obtain instructions on how to use help.



About Command (Help menu)

Use this command to display copyright text and the version number of your copy of Fractal 
Texture Composer.



Contextual help Command

Use the Contextual help command to obtain help on anything about Fractal Texture 
Composer. When you choose the « Contextual help » button from the toolbar, the mouse 
pointer changes to an arrow and a question mark. Click on something in the Fractal Texture 
Composer window, for example, another button in the toolbar. The help topic for the element
that you have just clicked on is displayed.

Shortcuts
Keys : CAPS +F1



Title bar

The title bar is situated at the top of a window. It contains the name of the application and 
the document.

To move the window, drag the title bar from the top with your mouse. Note : you can also 
move    dialog boxes by dragging their title bars from the top.

A title bar can contain the following elements :
The application’s System menu button
The document’s System menu button
« Maximize » button
« Minimize » button
Name of the application
Name of the document
« Restore » button



Scroll bars 

Scroll bars are displayed at the right and bottom of the document window. The scroll box is 
found inside the scroll bar, indicating the vertical and horizontal position in the document. 
You can use the mouse to scroll through other parts of a document.



Resize Command (System menu)

Use this command to display a four point arrow that permits you to resize the active window 
with the help of the arrow keys.

When the mouse pointer has taken the form of a four point arrow :
1. Use one of the arrow keys (LEFT, RIGHT, UP or DOWN) to move the pointer towards the 

border that you would like to move. 
2. Use an arrow key to move the border.
3. Press on the ENTER key when the window has attained the size that you would like.

Note : this command is not available if the window has been enlarged.

Shortcuts
Mouse : Drag the resize bars from the corner or border of the window.



Move command (System menu)

Use this command to display an arrow with four points, that permits you to move the active 
window or dialog box with the arrow keys.

Note : this command is not available if the window has been enlarged.

Shortcuts
Keys : CTRL+F7



Minimize command (application’s System menu)

Use this command to reduce the Fractal Texture Composer window to an icon.

Shortcuts

Mouse : Click on the Minimize icon  in the title bar.
Keys : ALT+F9



Maximize command (System menu)

Use this command to increase the size of the active window to take up all the available 
space.

Shortcuts

Mouse : Click on the Maximize icon  in the title bar or click twice on the title bar.
Keys : CTRL+F10 increases a document window.



Next window command (document’s System menu)

Use this command to proceed to the next document window. Fractal Texture Composer 
determines what the next window is by recalling the order in which you have opened the 
windows.

Shortcuts
Keys : CTRL+F6



Previous window command (document’s System menu)

Use this command to proceed to the previous document window. Fractal Texture Composer 
determines what the previous window is by recalling the order in which you have opened the
windows.

Shortcuts
Keys : CAPS+CTRL+F6



Close command (System menu)

Use this command to close the active window or dialog box.

Clicking twice on the System menu box equates to choosing the Close command.

Note : if you have several open windows for the same document, the Close command in the
document’s System menu closes only one window at a time. You can close all the windows 
at the same time by using the Close command in the File menu.

Shortcuts
Keys : CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box <<YourType>> 



Restore command (System menu)

Use this command to restore the size and position that the active window had before you 
used the    Maximize or Minimize command.



Task list command (application’s System menu)

Use this command to display a list of all the open applications. Use the Task list dialog box 
to activate or close an application represented in the list.

Shortcuts
Keys : CTRL+ESC

Dialog box options
When you choose the Task list command, you see a dialog box appear containing the 
following options :
Task list

Select the application that you would like to activate or close.
Switch to 

Make the selected application active.
End task

Close the selected application.
Cancel

Close the Task list dialog box.
Cascade

Arrange the open application windows to overlap so that each title bar is visible. This 
option does not affect applications reduced as icons.

Tile
Arrange the open windows in smaller sizes to fit next to each other on the desktop. This 
option does not affect applications reduced as icons.

Arrange icons
Arrange the reduced icons of all applications at the bottom of the screen.



Choose a color dialog box

Define a new color and place in the current palette :

1 Modify or create the color with one of the techniques or a combination of the 
following techniques :

* In the custom color selector zone, drag the cursor to the area where the desired color
is found.

* Drag the arrow on the brightness bar to the top or bottom to adjust the brightness of 
the color.

* In the "Red/Green/Blue" or "Hue/Saturation/Luminosity" text boxes, type the desired 
values.

You can type the values in the text boxes or click on the arrows situated at the right 
to increase or decrease values.

When you modify a color, the new color is displayed at the left of the "Color/Solid" 
zone. The right part of the zone displays the solid color that is closest to your choice. A solid 
color is a color directly available on your monitor. All unrecognized colors are represented by
a screened color.
If you have selected the solid color, click on the right part of the box.

Note : if the brightness is equal to 0, all the colors are black. When the brightness is 
equal to 240, all the colors are white.

When the color is satisfactory, click on "OK".    



Repeat command (Edit menu)

Use this command to repeat the last modification action performed. The Repeat command 
becomes the Impossible to repeat command if the last action can’t be repeated.

Shortcuts
Key : F4



Modification of document





Help not available

No help is available for this area of the window.



Help not available

No help is available for this message.





Commande Imprimer (menu Fichier)

Utilisez cette commande pour imprimer un document. Cette commande affiche la boîte de 
dialogue Imprimer, dans laquelle vous pouvez indiquer les pages que vous souhaitez 
imprimer, le nombre de copies, l'imprimante destination et d'autres options de configuration
de l'imprimante.

Raccourcis

Barre d'outils :
Touches : CTRL+P



Boîte de dialogue Imprimer

Les options suivantes vous permettent de spécifier les critères selon lesquels vous souhaitez
que le document soit imprimé :
Imprimante

Il s’agit de l'imprimante et de la connexion d'imprimante actives. Choisissez l'option « 
Configuration » pour changer d'imprimante et de connexion d'imprimante.

Configuration
Affiche la boîte de dialogue Configuration de l  ’  impression  , qui vous permet de choisir une
imprimante et une connexion d'imprimante.

Etendue
Spécifiez les pages que vous souhaitez imprimer :
Tout Imprime la totalité du document.
Sélectio
n

Imprime le texte sélectionné.

Pages Imprime les pages que vous avez spécifiées dans les zones « De » 
et « A ».

Copies
Indiquez le nombre de copies que vous souhaitez imprimer pour la suite de pages 
spécifiée.

Copies triées
Imprime les copies dans l'ordre des numéros de page, au lieu de plusieurs copies 
séparées de chaque page.

Qualité d'impression
Sélectionnez la qualité d'impression. Généralement, l’impression est d’autant plus rapide
que la qualité d’impression choisie est faible.



Boîte de dialogue Etat d'avancement de l'impression

La boîte de dialogue Impression s’affiche pendant que <<YourApp>> envoie la sortie vers 
l'imprimante. Le numéro de page indique l'état d'avancement de l'impression.

Pour abandonner l'impression, choisissez le bouton « Annuler ».



Commande Aperçu avant impression (menu Fichier)

Utilisez cette commande pour afficher le document actif tel qu’il apparaîtra à l'impression. 
Lorsque vous choisissez cette commande, la fenêtre principale est remplacée par une 
fenêtre Aperçu avant impression dans laquelle une ou deux pages sont affichées telles 
qu’elles seront imprimées. Les différentes options de la barre d'outils Aperçu avant 
impression vous permettent de visualiser les pages une à une ou deux par deux, vous 
déplacer de page en page à travers le document, faire un zoom avant et un zoom arrière 
des pages et lancer un travail d’impression.



Barre d'outils Aperçu avant impression

La barre d'outils Aperçu avant impression contient les options suivantes :
Imprimer

Affiche la boîte de dialogue Imprimer pour démarrer un travail d'impression.
Page suivante

Affiche l'aperçu avant impression de la page suivante.
Page précédente

Affiche l'aperçu avant impression de la page précédente.
Une page / Deux pages

Affiche les pages une à une ou deux par deux.
Zoom avant

Présente une vue réduite de la page imprimée.
Zoom arrière

Présente une vue agrandie de la page imprimée.
Fermer

Quitte la fenêtre d'aperçu avant impression et revient à la fenêtre de modification.



Commande Configuration de l'impression (menu Fichier)

Utilisez cette commande pour sélectionner une imprimante et une connexion d'imprimante. 
Cette commande affiche la boîte de dialogue Configuration de l'impression, dans laquelle 
vous pouvez spécifier l'imprimante et sa connexion.



Boîte de dialogue Configuration de l'impression

Les options suivantes vous permettent de sélectionner l'imprimante destination et sa 
connexion.
Imprimante

Sélectionnez l'imprimante que vous souhaitez utiliser. Choisissez l’option « Imprimante 
par défaut » ou l'option « Imprimante spécifique » et sélectionnez l’une des imprimantes 
déjà installées dans la zone. Vous installez les imprimantes et configurez les ports en 
utilisant le Panneau de configuration de Windows.

Orientation
Choisissez « Portrait » ou « Paysage ».

Taille du papier
Sélectionnez la taille du papier sur lequel le document sera imprimé.

Alimentation
Certaines imprimantes disposent de plusieurs bacs d’alimentation papier. Spécifiez ici le 
bac utilisé.

Options
Affiche une boîte de dialogue qui vous permet de choisir des options d’impression 
supplémentaires et spécifiques au type d'imprimante sélectionné.

Réseau...
Utilisez ce bouton pour vous connecter à un emplacement réseau, en lui attribuant une 
nouvelle lettre de lecteur.



Commande Mise en page (menu Fichier)

<< Write application-specific help here. >>




